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Exorapid-qIC®
Immunochromatographic kit for

extracellular vesicles

(CD9, CD63, CD81 set)
[Cat.No. :DNT-EXO-K123]

Instruction Manual

Handling Precautions

e This product is for research use only.
X Since it is not subject to the Pharmaceuticals and Medical Devices Act, it cannot be
used for diagnostic purposes.

e Store in a cool, dark place (4°C) away from heat and humidity.

* Please pay attention to the following points when using the Imm
unochromatographic Test Strip (Contents No.1).
®Do not use near open flames
@Moisten before disposal
®Avoid storing at room temperature
@Avoid direct sunlight
®Avoid impact and friction

* Dispose of waste liquid and other waste materials in accordance with |
ocal regulations.

* Wear recommended personal protective equipment (lab coat, safety gla
sses, mask, rubber gloves, etc.).

e Wash hands thoroughly after handling.

* Be careful not to inhale dust etc.

 If the solution gets into your eyes or mouth, immediately rinse thorou
ghly with water for several minutes. If irritation persists, seek medical
advice.




» Introduction

Before using the Exorapid-qIC® Immunochromatography Kit for Extracellular Vesicles [Cat.
No. : DNT-EXO-K01, K02, KO3], you can use this product (set of products) to determine which
antibody species are suitable for immunochromatographic detection of your extracellular

vesicles.

Different detection between the antibody species coated on the immunochromatographic test
strip and the antibody species labeled on the gold nanoplates is possible.

strip: CD9 antibody, gold nanoplate: CD63 antibody.]

» Kit Component

[Example: Test

Quantitiy
No. Component
CD9 CD63 CD81
CD9 antibody coated Immuno . . .
1 Y _ e 7 strips™? 7 strips™? 7 strips™?
-chromatographic Test strip”
Gold nanoplate labeled 1 bottle 1 bottle 1 bottle
2 antibody (Equivalent to (Equivalent to (Equivalent to
[lyophilized product] 220 pL)*® 220 pL)*® 220 pL)*®
1 bottle 1 bottle 1 bottle
Standard substance ) ) )
3 N (Equivalent to (Equivalent to (Equivalent to
[lyophilized product] sca a4 x4
105 ng)” 280 ng)” 28 ng)”
4 Dilution solution 1 bottle (0.9 mL)
5 Washing solution 1 bottle (10 mL)
6 Assay microplate 96 Well 1 plate
7 Instruction manual 1 copy

% 1. To distinguish the antibody type, lines are drawn in pencil on the absorbent paper

(No line: CD9, one line: CD63, two lines: CD81).

%2. The number of strips are contained about 10% (4 bottles) more as a reserve.

%3. 6 analyses (180 pL) + 40 pL reserve.

%4. Dissolve in 140 pL of purified water to prepare a solution with a concentration

(CD9: 0.75ng/pL, CD63: 2.0ng/pL, CD81 0.20ng/pL).

» Materials Not Included in the kit

Micropipettes Paper towels

. Microtube
Tabletop mixer (for tubes)

(recommended volume: 0.5-2.0 mL)

Tweezers Purified water™>
Tapes Tabletop Centrifuge

Immunochromatography measuring device or scanner

% 5. Pure water, ultrapure water, distilled water, etc.

» Precautions for use

Ex.) Appearance of test
strip
CD9 CD63 CD81

Please open the aluminum pouch and remove the freeze-dried product contents and
Immunochromatographic Test Strips after returning them to room temperature.

Contents may be attached to the cap or inside wall of the tube.

Before opening, please remove any dirt by flushing with a tabletop centrifuge.
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» Outline

Step0. Preparation R _ 1. Setting up the microplate.
[Fig.1-(a)]
< Placing the lid underneath, can
slope a plate to make it easier to
spread samples.

2. Remove the required number of
test strips. Do not use any that
have large pieces of peeling off.

[Fig.1-(b)]

Inject 20 pL of the standard substance (rCD9
solution) and your sample solution into each well.
[Fig.2-(a)]

Place the test strip in each well with the absorbent
paper up.[Fig.2-(b)]

3. Check that the solution in the wells has
disappeared. [Fig.2-(c)]

10 min.

Fig.-2-(a) Fig.2-(c) & Once samples has been developed, proceed
immediately to the next step to prevent the test

solution (1st time)
Inject 10 pL of Washing solution into the same wells as

in Step 1. [Fig.3-(a)]

="Make sure that the washing solution (droplets) falls
to the bottom of the well.

=If you use tweezers to lift the test strip and place it
back into the same well, the water will be developed
more quickly. [Fig.3-(b)]

5 min.

Step3. Development of Gold nanoplate labeled antibodies

1. Inject 30 pL of Gold nanoplate labeled antibody
solution into the same wells as in Steps 1, 2.

[Fig.4-(a)]

c
£ < Please refer to the notes in Step 2.
b 2. When the Gold nanoplate labeled antibody
solution is developed, the test line (lower side)
: B £y and control line (upper side) gradually become
Fig.4-(a) Fig.4-(b) colored.
Step4. Development of Washing solution (2nd time)
Add 50 pL of washing solution to each new well. [Fig.5]
< Please refer to the notes in Step 2.
c
£
Tp]
i

Analysis



» Protocol
<Detection Test>

1 Preparation of standard substance solution for positive controls
@ Dissolve each standard substance (rCD9 or rCD63 or CD81 peptide) [lyophilized
product] by injecting 140 L of purified water into the tube containing the standard
substance and mixing with a table-top mixer.
@ After dissolution, dilute each standard 2-fold with Sample diluent, and mix with a
table-top mixer. (Table 1)
Tablel. Concentration of standard material solution to be prepared
T Purified water| concentration of @ | concentration of @
(HL) (ng/20uL) (ng/20uL)
rCD9 140 15 7.5
rCD63 140 40 20
CD81 Peptide 140 4.0 2.0
2 Preparation of sample diluents
Add Dilution solution to your sample solution containing extracellular vesicles so that
the amount of diluents spread on each immunochromatographic test strip is 20 pL
(e.g., 5 pL of your sample solution + 15 pL of Dilution solution).
After dilution, sample diluents are left on ice for 1 hour (to prevent clogging of the
samples during immunochromatography).
3 Preparation of Gold nanoplate labeled antibody solution
Add 220 pL of purified water to the Gold nanoplate labeled antibody (lyophilized
product) and dissolve by stirring using a tabletop mixer.
4 Injection of each developing solution and development of the solutions onto
Immunochromatographic Test Strips
Inject 20 pL of @ Dilution solution (blank solution), @ rCD9 solution of each
concentration prepared in "1 Preparation of standard substance (rCD9) solution for
calibration curve", and ® sample diluents prepared in "2 Preparation of sample
diluents" into separate wells.
Remove the Immunochromatographic Test Strip that has been brought to room
temperature from the aluminum pouch and place it on the paper towels without
touching the bottom of the test paper. Discard any that have significant peeling.
Using tweezers, soak the strip vertically into the wells into which the above solutions
have been poured, allowing each solution to developed into the
Immunochromatographic Test Strip™® (time required: about 10 minutes).
5 Washing of Immunochromatographic Test Strips

After confirming that each solution has been fully developed, inject 10 uL of Washing
solution into the same well and re-soak the Immunochromatographic Test Strip (time
required: about 5 minutes).




6 Development of Gold nanoplate labeled antibodies
Add 30 pL of Gold nanoplate labeled antibody solution to the same well and re-soak
the Immunochromatographic Test Strip.
At this stage, the test line and control line will turn blue (time required: about 15
minutes).

7 Washing of Immunochromatographic Test Strips
Inject 50 pL of Washing solution into an unused well and soak the
Immunochromatographic Test strip in the Washing solution for 15 minutes.

8 Quantification of extracellular vesicles in samples
The intensity of the test line is measured using ®@CMS*’, @Imagel *8, ®an
immunochromatographic measuring device, etc.

%6. Standard substance can only be detected on the same type of antibody-coated test strips.

X7.

*8.

Abbreviation for Color Management System released by TOPPAN Corporation. [Currently under

consideration for implementation]
(Release article : https://www.holdings.toppan.com/ja/news/2024/02/newsrelease240227_1.html )

See the next page for the analysis method using Imagel.



https://www.holdings.toppan.com/ja/news/2024/02/newsrelease240227_1.html

<Analysis method Example: stainintg inrtensity measurement using Imagel>

1 Photographing the test strip
After samples are spread, the test paper is photographed with a digital camera or
scanner, and the image data is saved in JPEG format.
= It will be easier to photograph it if you attach it to a mount or similar before
photographing it.

2 Preparation of Imagel
® Download
Download the public domain image processing software "Image J" from the following
URL.
URL : https://imagej.net/ij/ (As of July 22, 2024)
Select "Image]" from the downloaded file set and launch it.

For detailed basic operations, please refer to the following URL.
URL : https://imagej. nih. gov/ij/docs/qguide/user-guide. pdf(As of July 22, 2024)
@ Setup
Select the “Analyze” tab — “Set Measurements” and check “Area” and “Mean grey

value”.
image) - X
File Edit Image Process Analyze Plugins Window Help | £ Set Measurements X
D.[Q Q|| /4| Measure c+M 4| & | A|7| |>

v [Areal ¥ Mean gray value

'Rectangle®, rounded rect or rotat Analvze Particles
o [~ Standard deviation [~ Modal gray value

Summarize
[ Min & max grayvalue [~ Centroid
Distribution
[ Center of mass [~ Perimeter
Label |
[~ Bounding rectangle [~ Fitellipse
Clear Results
[~ Shape descriptors [~ Feret's diameter
Set Measurements...
™ Integrated density I~ Median
|
Set Scale I~ Skewness I™ Kurtosis
Calibrate [~ Area fraction [~ Stack position
Histogram Ctrl+H
Plot Profile Ctri+K | I~ Limittothreshold I~ Display label
Surface Plot | T InvertY coordinates |~ Scientific notation
|
Gels ' [~ Add to overlay ™ NaN empty cells
Tools » [
Redirectto: |None ~
| Decimal places (0-9) 3
OK Cancel | Help
Fig.6-(a) Fig.6-(b)



https://imagej.net/ij/
https://imagej.nih.gov/ij/docs/guide/user-guide.pdf

3 Loading test strips image
Select the “File” tab — “Open” to load the image file.
Images in formats other than JPEG may not be analyzed correctly, so convert them
to JPEG before use.

¢ mage) - %
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Close All Ctri+Shift+W
Save cuiss
—
Save As » -
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Fig. 7

< Magnifier tool
‘:Flle Edit Image Process Analyze Plugins Window Help
Olola|o|/ <)% AR ™| 4] crlow £ 8]~ >

["Straight", segmented or freehand lines, of arrows (night click to switch)

Click on the tool to zoom the image.

== Scroll tool

{ Image)
| File Edit Image Process Analyze Plugins Window Help

|aloja|o| /|« N Al A cro £] 8]~ =

[Color pecker 255,255 265/0,0.0 (nght click for menu)

To move the image in the window, select this tool and move it.
*If you want to continue the analysis after using the above tools, please
select a new rectangular ROI first.

4 ROI Manager Z¢
Select the Rectangle ROI (rectangle area selection tool) from the toolbar.
Open “Analyze” tab — “Tools” — “ROI Manager”.
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Plot Profile Ctri+K

Surface Plot...
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Analyze Line Graph
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Scale Bar...
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Synchronize Windows
| Grid...
Fig.8




5 Test line, background staining intensity measurement

@ Enter test line information

Draw a rectangle around the test line area™’ in the image and type "T" on the
keyboard to enter the information about the area into the ROI Manager.

@ Enter background information
Drag and drop a rectangle of the same area as the test line area to select the

uncolored part of the test paper, and enter the background area information into

the ROI Manager using the same procedure as in @.

Repeat steps @ and @ above for all test strips to be analyzed.
Check "Show All" and "Labels" to display the selection area and numbers on the image,
and check that the selection area and order are correct.

4 RO. — ul X
E— " |0433-.0103 ~|  Add[
0438-0319
Update
2 3 0433-0529
387-0103 IEEE
0387-0318 Rename...
0384-0525 Measure
Deselect
- —_ - -
e . [ Properties...
- L — Flatten [F]
hore »
/% show Al
¥ Labels
Fig.9-(a) Fig.9-(b)

X9,
affect the quality.
% 10. Detection lines may also appear in the Blank test. There is no quality problem.

If the amount detected is small, the center of the test line may be faint, but this does not

Detection strength calculation

Select the information entered in the ROI Manager in the previous section, and click
"Measure" in the ROI Manager window. The Results window will open and the average
luminance (Mean) of the area enclosed in a rectangle will be displayed. Select all of
these, paste them into Excel, and subtract the "Mean" of the test line from the "Mean"
of the background to calculate the staining intensity (detection intensity).
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Fig.10-(a)

Part pasted from the Result window

Fig.10-(b)

» Contact

Dai Nippon Toryo Company,Limited
SPECIALITY BUSINESS DIV. NEW BUSINESS DEVELOPMENT DEPT.

E-mail : evs-support@star.dnt.co.jd



